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Overview

Purpose
This document explains how to install or upgrade the Oracle Workflow and 
Oracle XML Gateway components that reside on a client PC. This 
document applies to the Oracle Workflow and Oracle XML Gateway client 
components available with Oracle Applications.

Audience
These notes are written for the person or persons responsible for installing 
or upgrading Oracle Workflow and Oracle XML Gateway client 
components. The person(s) performing this installation may need assistance 
from the:

■ Operating System Administrator

■ Oracle System Administrator

■ Oracle DBA

Oracle Workflow and Oracle XML Gateway Client
Oracle Workflow and Oracle XML Gateway contain several client 
components that are installed using the Oracle Universal Installer from the 
Oracle Workflow Client CD:

■ Oracle Workflow Builder for Windows NT, Windows 98, Windows 
2000, or Windows XP

■ Oracle Workflow Common Files
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■ Oracle Workflow HTML help

■ Oracle XML Gateway Message Designer for Windows NT, Windows 98, 
or Windows 2000

■ Oracle XML Gateway Message Designer HTML help

The Oracle Universal Installer and the Oracle Workflow and Oracle XML 
Gateway client installation instructions and components are included on 
the Oracle Workflow Client CD. The CD contains the following directory 
structure and files when viewed from a PC with access to a CD-ROM drive:

■ Oracle Workflow and Oracle XML Gateway Client Components - 
\install\win32

■ Installation Notes - \wfinstcl.pdf, \wfinstcl\toc.htm

Oracle Workflow and Oracle XML Gateway Client Hardware 
and Software Requirements
The client components of Oracle Workflow and Oracle XML Gateway must 
be installed into an Oracle9i Release 2 (9.2) client Oracle Home directory. 
They require the following hardware and software configurations.

Oracle Workflow Builder 
Oracle Workflow Builder is a GUI tool that allows you to create and edit 
workflow definitions on a PC running either Microsoft Windows 98, 
Windows 2000, Windows NT, or Windows XP. A workflow definition can 
be saved to a flat file or to your Workflow Server database if you have 
Oracle Net installed on your PC. Oracle Workflow Builder requires the 
following hardware and software configurations:

■ Oracle Net Client Version 9.2.0.1 or higher (included in the Oracle 
Workflow Client installation)

■ Required Support Files Version 9.2.0.1 or higher (included in the Oracle 
Workflow Client installation)

■ An IBM, Compaq, or 100% compatible personal computer with the 
following: 

- A 486 processor or better

- Clock speed of 66 Mhz or greater (90 Mhz or greater is 
recommended)

- Network card

- SVGA color monitor
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- Modem configured with dial-in access for use by Oracle Worldwide 
Customer Support. At least one PC at your site should be 
configured with a modem.

- Remote access and control software to be used by Customer 
Support for dial-in access through a modem to your PC. The 
preferred software is Symantec’s Norton pcANYWHERE or 
Microcom’s Carbon Copy.

Without some form of remote access and control software, Oracle 
Worldwide Customer Support will not be able to dial in to your site 
to diagnose problems, nor will they be able to supply patches 
directly to your client PC.

- ISO 9660 format CD-ROM available as a logical drive

- Microsoft Windows 98, Windows 2000, Windows XP, or Windows 
NT 4.0 or higher

- At least 65 Mb of available disk space to install Oracle Workflow 
Builder, Oracle Net, and Required Support Files.

- At least 32 Mb of memory, 64 Mb recommended

Oracle XML Gateway Message Designer
The Oracle XML Gateway Message Designer is a wizard-guided, 
GUI-oriented, repository-based tool that allows you to create XML message 
maps on a PC running Microsoft Windows 98, Windows 2000, or Windows 
NT. The Message Designer requires the following:

■ Either JDK 1.1.8 or JRE 1.1.8 or higher. JRE 1.1.8 is included in the 
Message Designer installation.

WARNING: Please follow the necessary security precautions 
against viruses and unauthorized access when installing any 
software that allows remote access.

Note: The Oracle TCP/IP Protocol Adapter requires and 
only supports the use of Microsoft’s TCP/IP drivers.

Note: Oracle Workflow Builder currently cannot be 
installed on a central file server or be shared by other client 
PCs over the network.
 3



■ At least 15 Mb of available disk space to install Oracle XML Gateway 
Message Designer, HTML help, and JRE 1.1.8.

Oracle Workflow and Oracle XML Gateway Client 
Installation
Perform the following steps to install the Oracle Workflow or Oracle XML 
Gateway client components on a PC. The installation should take 
approximately 10 minutes, depending on your system’s speed and capacity.

Step 1. Install Oracle Workflow or Oracle XML Gateway client 
components using the Oracle Universal Installer. 
1. Insert the Oracle Workflow Client CD into your PC’s CD–ROM drive. 

Choose Run from the taskbar Start button and enter the following 
command to run the Oracle Universal Installer:

<CD_ROM_drive_letter>:\install\win32\setup.exe

2. When the Oracle Universal Installer is started, the Welcome window 
appears. Click Next.

3. The File Locations window appears. Review the stage location of the 
Oracle Workflow and Oracle XML Gateway client files, and enter the 
Oracle Home location where you want to install client components. 
Then click Next.

4. The Available Products window appears. Select whether you want to 
install the Oracle XML Gateway Message Designer or the Oracle 
Workflow Builder. Then click Next.

Note: Any variable input in the following commands is 
enclosed in brackets and is italicized. Replace these 
variables with the appropriate information specific to your 
environment.

Note: Click Help in any Oracle Universal Installer 
window for more information about that window.
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5. If you are installing Oracle Workflow components and you are 
installing Java Runtime Environment for the first time, the Component 
Locations window appears. Enter the destination location where you 
want to install Java Runtime Environment. Then click Next.

6. The Summary window appears. Review the summary information to 
ensure you have enough disk space. When you are ready to begin the 
installation, click Install.

7. The Install window appears, displaying the progress of the installation.

8. If you are installing Oracle Workflow components and you are 
installing Oracle Net Client for the first time, the Configuration Tools 
window appears when the installation is complete, and the Oracle Net 
Configuration Assistant automatically starts.

In the Oracle Net Configuration Assistant window, select a method by 
which to configure client access to your Oracle database. The Oracle 
Net Configuration Assistant helps you configure your client access.

9. The End of Installation window appears. Click Exit to exit the Oracle 
Universal Installer. You can also click Next Install to return to the File 
Locations window and install another component.

10. If you are installing Oracle Workflow Builder on a Windows 98 PC, you 
must exit Oracle Universal Installer after the installation is complete 
and reboot your PC before starting Oracle Workflow Builder.

Note: When you install the Oracle XML Gateway 
Message Designer, its HTML help is automatically installed 
as well.

When you install the Oracle Workflow Builder, the Oracle 
Workflow Common Files and the Oracle Workflow HTML 
help are automatically installed as well.

Note: Refer to the Oracle9i Client Installation Guide for 
more information about running the Oracle Net 
Configuration Assistant.
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Step 2. Set up the Oracle Workflow HTML help (optional). 
When you install Oracle Workflow Builder, the Oracle Universal Installer 
copies a zip file containing the HTML help to the Workflow directory in 
your Oracle Home. The zip file is <ORACLE_HOME>\wf\wfdoc.zip. 
Before you can view the HTML help, you must extract the doc directory 
tree from the zip file to your file system.

1. Use an unzip utility to extract the doc directory tree from the zip file 
within the Workflow directory. You need at least 7 Mb of free disk space 
to extract the zip file.

The doc directory tree that is created includes the Oracle Workflow 
documentation area, <ORACLE_HOME>\wf\doc, and the following 
subdirectories: 

■ <ORACLE_HOME>\wf\doc\<lang>\wf - Oracle Workflow online 
help.

■ <ORACLE_HOME>\wf\doc\<lang>\wfcust - Custom help. You 
can optionally add your own customized Workflow help in this 
directory.

Caution: It is very important that you reboot your PC 
before starting Oracle Workflow Builder for the first time 
on Windows 98 to ensure that the required versions of 
Workflow Builder files are loaded into memory as 
necessary.

Note: In some cases you may see the following error 
message during the installation: "Error encountered when 
registering <filename>, please run regsvr32.exe manually to 
register this file after the installation completes". For 
example, you may see this error for the wfnvg.ocx file.

If you encounter this error, close the error message and 
proceed with the installation. After the installation is 
complete, register the specified file manually by running 
the following command from a DOS prompt:

regsvr32 <path>\<filename>

Replace <path> with the path to the file and <filename> 
with the name of the file to register. The wfnvg.ocx file is 
normally located in the <ORACLE_HOME>\bin directory.
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2. After extracting the doc directory tree, you can optionally remove the 
zip file.

3. You can now view the HTML help using a Web browser.

The path for the contents page of the Oracle Workflow documentation 
is:

\<ORACLE_HOME>\wf\doc\<lang>\wf\toc.htm

The path for the contents page of your Oracle Workflow custom help is:

\<ORACLE_HOME>\wf\doc\<lang>\wfcust\wfcust.htm

You can also view context-sensitive help for the Oracle Workflow 
Builder in Winhelp format by choosing Contents from the Help menu 
within the Oracle Workflow Builder.

4. If you want to add custom help, you can replace the placeholder file in 
the wfcust directory, wfcust.htm, with your own help material. The 
HTM file that is the main entry point for your custom help must be 
named wfcust.htm and must contain an anchor named contents. 
Your custom help will be accessible through the Custom Help link on 
the contents page of the Oracle Workflow online help.

Step 3. Modify fonts in the Oracle Workflow Builder (optional). 
If you are installing the Oracle Workflow Builder in another language such 
as Japanese, you can modify the font used by the windows in the Oracle 
Workflow Builder to a font that is appropriate for your language. Any 
change you make applies to all windows within the program.

1. Choose Font from the View menu to display the Fonts properties page.

2. Select the font you want to use in the labels for your icons and in the 
navigator tree. The Sample region shows the appearance of the font you 
select. For example, when using the Oracle Workflow Builder in 
Japanese, you might choose the font MS PGothic.

Note: You can also install the doc directory tree in a 
directory that you choose on your PC file system. Create a 
directory for the HTML help. Then transfer the HTML help 
zip file, wfdoc.zip, from the Workflow subdirectory 
within your Oracle Home to the new directory. Use an 
unzip utility to extract the doc directory tree from the zip 
file in that directory.
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3. Select the font style: Regular, Bold, Italic, or Bold Italic. Some fonts have 
a limited selection of font styles.

4. Select the font size to use. Some fonts have a limited selection of font 
sizes.

5. Select the Underline or Strikeout check boxes to apply those effects.

6. Choose OK when you are finished.

7. Close and restart the Oracle Workflow Builder. The new font settings 
should then take effect. 

Step 4. View the Oracle XML Gateway Message Designer HTML 
help (optional).
When you install the Oracle XML Gateway Message Designer, the Oracle 
Universal Installer automatically installs the Message Designer HTML help 
as well. The HTML help is located in the ecx\help subdirectory within 
your Oracle Home. You can view the help by choosing Help Topics from 
the Help menu within the Oracle XML Gateway Message Designer, or you 
can access the help directly using a Web browser. The path for the contents 
page of the Message Designer help is:

\<ORACLE_HOME>\ecx\help\ecxmdtoc.htm

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting 
documentation accessible, with good usability, to the disabled community. 
To that end, our documentation includes features that make information 
available to users of assistive technology. This documentation is available in 
HTML format, and contains markup to facilitate access by the disabled 
community. Standards will continue to evolve over time, and Oracle 
Corporation is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the 
Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. 
The conventions for writing code require that closing braces should appear 
on an otherwise empty line; however, JAWS may not always read a line of 
text that consists solely of a bracket or brace.
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Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle 
Corporation neither evaluates nor makes any representations regarding the 
accessibility of these Web sites. 
 9



 10


	Overview
	Purpose
	Audience

	Oracle Workflow and Oracle XML Gateway Client
	Oracle Workflow and Oracle XML Gateway Client Hardware and Software Requirements
	Oracle Workflow Builder
	Oracle XML Gateway Message Designer

	Oracle Workflow and Oracle XML Gateway Client Installation
	Step 1. Install Oracle Workflow or Oracle XML Gateway client components using the Oracle Universa...
	Step 2. Set up the Oracle Workflow HTML help (optional).
	Step 3. Modify fonts in the Oracle Workflow Builder (optional).
	Step 4. View the Oracle XML Gateway Message Designer HTML help (optional).

	Documentation Accessibility

